CHAPTER II

REVIEW OF RELATED LITERATURE

A. Previous Research

There have been many research which attempt to study the topic related to teach grammar especially simple past tense in many classroom. Here are some studies concerning to it.

The thesis entitled The Effectiveness of Cooperative Learning of Teams Games Tournaments for Teaching Grammar to Eight Grade of MTsN Kudus In Academic Year of 2008/2009 by Siti Ulinnikmah tried to the implementation of use a TGT. The research was quantitatif. The finding shown that the implementation of TGT in teaching Grammar in the classroom of Islamic lesson could increase the cooperation between the teacher and the students and could also improve the students’ religious development and independence in learning the subject.\(^1\)

The other thesis discussing the importance of grammar which the researcher has found is entitled Song as Alternative for Teaching

\(^1\) Siti, Ulinnikmah NIM: 3104056 Tarbiyah Faculty, “THE USE OF COOPERATIVE LEARNING OF TEAMS GAMES TOURNAMENTS FOR TEACHING GRAMMAR”, Thesis (Semarang: State Institute of Islamic Studies Walisongo Semarang, 2008), unpublished thesis.
Grammar at Elementary School written by Bedy Budiwoyo (Language and Art Faculty of State University of Semarang, 2006). He attempted to offer the song to be used for teaching grammar to the children. He found that actually song can help the children learn. As we know that it is very difficult to teach grammar to children. His research focused on teaching grammar because of the view that grammar is the basic component of language competence which should be possessed since childhood.²

However, the first thesis stated that the research was conducted is Islamic teaching context while this research will be in English teaching learning context. The second one was carried out in English language teaching context and the focus of study is the same with the researcher’s, that is the importance of grammar in English teaching learning. In other hand, there is a difference between Bedi’s and researcher’s study. In this study, the researcher try to offer one of teaching media while the previous one offered teaching media, that is Joepardy, to teach grammar. The researcher hopes that this study can fill in the gap in teaching learning, especially in English teaching learning context and give positive contribution although it is just a little.

B. **Learning Media**

Media are generally defined as the means by which information is conveyed from one place to another. In the past century, various forms of media have been used to convey instruction and to support learning. Examples of instructional media include traditional means of delivering instruction (chalkboards, textbooks, overhead projectors, and teachers), mass media used for education (newspapers, movies, radio, and television), and the newer "electronic" instructional media (computers, interactive video, and multimedia systems). Media can be defined by their technology, their symbol systems, and their processing capabilities.

The most obvious characteristic of a medium is its technology, the mechanical and electronic aspects that determine its function and to some extent its shape and other physical features. These are the characteristics that are commonly used to classify a medium as a "television," a "radio," and so on. The cognitive effects of these characteristics, if any, are usually indirect. Characteristics such as size, shape, and weight make it more likely that a student will learn with a book while on a bus but not a computer, though of course this is changing as computers get smaller, lighter, and cheaper. On the other hand, some cognitive effects of technology are more direct. For
example, the size and resolution of many computer screens is such that reading text may be more difficult than it is with books.\(^3\)

All instruction requires the selection and use of at least one medium to deliver instruction. Many alternative media and mixtures of media may be chosen for any given learning goal and group of students. Thus, research questions have compared the learning benefits of various media and mixes of media for different types of learning goals and students at different ages and aptitude levels. Thousands of studies have been and continue to be conducted.\(^4\)

From the definition, in his 2001 book *Learning from Media*, Richard E. Clark concluded that there are no learning benefits from any specific medium or mix of media. He summarized the research on this issue in an analogy that is often repeated: "The best evidence is that media are mere vehicles that deliver instruction but do not influence student achievement any more than the truck that delivers our groceries causes changes in our nutrition. Basically, the choice of vehicle might influence the cost or extent of distributing instruction, but only the content of the vehicle can influence achievement" (p.13). While some media will not convey certain types of information

---


necessary for learning (for example, newspapers cannot transmit sound or "real-time" visual events), any necessary information can be conveyed by a number of media (sound and visual events can be conveyed by many media other than newspapers). A more positive way to state this conclusion is that educators can expect similar levels of learning from a great variety of media provided that essential instructional methods are used. When more than one medium can provide the instructional method needed for learning, the choice of medium is based on expected economic benefits such as the per-student cost of instruction, not learning benefits. An alternative view was expressed in 1994 by Robert B. Kozma, who contended that media and method should not be separated.  

Media and method the key issue here is that when media are used for instruction, they may often be confused with the instructional methods and information they convey. For example, computer-based instruction is often thought to be highly "interactive" because computers permit high levels of exchange between student and computer-delivered instructional programs. Yet most media permit interaction, although some media do so more quickly and

---

economically. The principles of Computer-based instruction can be applied to courses for learners at any level of language learning.⁶

Any medium seems to be able to increase learning provided that the information content and instructional methods they convey are adequate to support student learning. The existing research suggests that when learning is influenced by external events, those events must support the use of mental processes that are required for learning goals by students who are unable or unwilling to provide them for themselves. The specification for these external events is what Clark called an "instructional method." Instances of common instructional methods are learning plans, examples, and practice exercises with interactive, corrective feedback. Since a variety of media will present any of the common instructional methods required to learn, the benefits of media are not in their impact on learning but instead in their economic impact and their capacity to increase access to educational information and instructional programs.

---

C. **Jeopardy Game**

1. Jeopardy

   Jeopardy is a game that many teachers utilize to give students a chance to practice their knowledge, learn more information and have a little bit of fun with the reviews they are doing for a class. It is an easy to use Jeopardy program written in Power point. Power point can easily be used to create a Jeopardy. There are several web sites available that provide ready-made Jeopardy Powerpoint templates, along with step by step instructions for adapting this popular game to your content.\(^7\) It features custom category listings, a timer, custom question, and answer sections, and it makes the question disappear from the main screen after it has been asked. Students love activities that consist of games or competitions.\(^8\)

2. Game

   Definition of game A Game is structured activity, usually Games are distinct from work, which is usually carried out for remuneration and from art, which is more concerned with the expression of ideas, An active interest or pursuit, especially one involving competitive engagement or adherence to rules: "the way

---

\(^7\) Tony Erben, Iona Sarieva, *CALLing ALL Foreign Languages Teachers*, (New York: Eye One education, 2008), p.70

\(^8\) Tony Erben, Iona Sarieva, *CALLing ALL Foreign Languages Teachers*, (New York: Eye One education, 2008), p.70
the system operates, the access game, the turf game, the image game".9

English is different from our language. Therefore it is not easy to learn it. One must make an effort to understand, to repeat accurately, to manipulate newly understood language and to use the whole range of known language in conversation or written composition. Games help and encourage many learners to sustain their interest work.

The classroom organization with this media allows learners to create an intergroup procedure so as to compare the degree of performance of the different teams. Joepardy Game guarantees the implication of each and every member of the group and allows them to compete with other members of the other teams who have a similar level to their own.

3. Procedure of Joepardy game

PowerPoint, Microsoft's presentation software that comes with their Office Productivity Suite, has been used for educational purposes since its inception. One of the most popular ways for teachers to use PowerPoint has been to make a Jeopardy-style trivia game using the program's slideshow mode. Many users, however, do not know how to achieve this game show effect using

---

PowerPoint. Luckily, making and playing a Jeopardy-style game in PowerPoint is an easy process, requiring only a few simple steps.

Interaction:

a. Create a new PowerPoint document. Click the "Format" tab from the application menu and select "Background" from the menu to choose the background color for your slides. Choose the font style and size you would like to use in your Jeopardy game from the font menu and click "Apply."

b. Click the "Insert" tab and select "Table" from the menu. Make your table have five columns and six rows and click the "OK" button. Click and drag the corner of the table to make it fill the slide.

c. Insert a category name into the top row slot of each column. Going down each column, insert the point values 10, 20, 30, 40 and 50, each in a separate box. Your table should now resemble a Jeopardy game board.

d. Click the "Insert" tab and select "New Slide" from the menu. Type a question on the blank slide. Create another new slide and type the answer to the question.
e. Return to the game board slide. Highlight the point value that you wish the question you wrote in Step 4 to be worth. Click the "Insert" tab and select "Hyperlink." Click the "Place in This Document" option from the menu. Click on the question slide you created in Step 4 and press the "OK" button to link the point value on the game board to the question.

f. Go to the answer slide you created in Step 4 and use the hyperlink process you used in Step 5 to link the answer slide text to the game board slide. This will allow you to easily return to the game board slide after every question.

g. Repeat Steps 4, 5 and 6 for every point value on the game board slide.

h. Play the game as a normal slide show. Click on the point values to reveal questions. Click on the answer text to be taken back to the game board.10

D. General Knowledge of Grammar

When we talk about grammar, we will discuss about second language acquisition as well. Second language acquisition, in this

10. Read more: Article By Alexander Poirier
http://www.ehow.com/how_7765603_jeopardy-game-instructions.html
point is English as the target language, is a complex process involving many interrelated factors. It refers to all the aspects of language that the learner needs to master. One of the factors is the mastery of grammar or language rules.¹¹

Before stepping forward to further discussion what should be discussed first is about the grammar itself. Actually there has been many definition stated by experts concerning to it as Harmer pointed out, then quoted by Robert Hoogenraad, that:

“Grammar is often associated in people’s minds with one of the following ideas: a dead language such as Latin, learning how to write ‘good English’, or learning how to speak ‘properly’. None of these ideas about grammar is completely wrong, but they do not represent the whole picture."¹²

From the definition above, it can be inferred that learning grammar is the same as learning how to produce appropriate sentence.

1. The importance of grammar

There is no doubt that knowledge of grammatical rules is essential for the mastery of language. Ur argued that the ability to

---

communicate effectively and accurately is probably not attained quickly or efficiently through the pure communication practice in the classroom - not at least, within the framework of a formal course of study. In other words, grammar is still needed in the classroom although it is not the main objective of language learning. Furthermore, the success of someone’s in acquiring his or her second language, in this case is English, is its grammatical mastery. As we know about black box theory argued by Chomsky that everyone is gifted a special ability which is called as a language acquisition device (LAD). This device was often described as an imaginary ‘black box’ which exist somewhere in the brain and discover the rules of the language.

2. Simple Past Tense

Tenses is one of component grammar. So tenses very important if we study english and improve to writing skill. Simple past is to declare activities that occur at a specific time in the past or to declare that the incident over and over and it has been customary in the past, the time that happens before this

---

13 Penny Ur, Grammar Practice Activities, (United Kingdom: Cambridge University Press, 2002), 8th ed, p.4-5.
time. Simple past tense is tense which is used for the previous or past of time. The past simple tense is sometimes called the "preterite tense". We can use several tenses and forms to talk about the past, but the past simple tense is the one we use most often.

Use the Simple Past to express the idea that an action started and finished at a specific time in the past. Sometimes, the speaker may not actually mention the specific time, but they do have one specific time in mind. Furthermore, simple past tense is a form that is used to refer to action or even completed in past time. Besides that, simple past use in Narrative, Recount, and Spoof texts. Simple past tense has any functions, as follows:

a) To indicate that something happened at the specific time in the past.
b) To indicate the situations that exists for a period of time in the past.
c) To indicate past habit.

3. Pattern of Simple Past tense

Table 1
Formulation of Simple Past Verbal

---

\(^{15}\) Maulani, Irlan, Let’s Study English Grammar, (Bandung: Thullab English Course,), p.14.
Formulate Simple Past | Examples
--- | ---
Positive | $S + \text{Did/V2} + O$ | I work yesterday
Negative | $S + \text{Did} + \text{Not} + O$ | He did not eat breakfast
Introgative | Did + $S + V1$ | Did they study yesterday?

The functions are used:

a) To indicate that something happened at the specific time in the past.
   Example: Andi played football last week.
   Intan went to Lombok yesterday.

b) To indicate past habit
   Example: She always carried an umbrella.
   He usually spoken English.

c) To indicate an event that really happened in the past but doesn’t mention the time.
   Example: I bought this car in Jakarta.
   When did you see her?

In the simple past tense, the interrogative and negative form always use the auxiliary verb “did” for all the subject, when the predicate is a verb.

Example: a. Did you play football yesterday?
   b. Did Andi study last night?
4. Use of “was and were” (pattern of Nominal Sentence),

**Table 2**

**Formulation of Simple Past Nominal**

<table>
<thead>
<tr>
<th>Simple Past</th>
<th>Positive</th>
<th>Negative</th>
<th>Introgative</th>
</tr>
</thead>
<tbody>
<tr>
<td>Verbal</td>
<td>S+ Did/V2+O</td>
<td>S+ Did+Not+O</td>
<td>Did + S + V1</td>
</tr>
<tr>
<td>Nominal</td>
<td>S+Was/Were+C</td>
<td>S+Was/Were+Not+C</td>
<td>Was/Were+S+C</td>
</tr>
</tbody>
</table>

Example: a. Was Rudy tired yesterday?

   c. We were happy last night.

Note that in the past tense form (was and were) do not use “did” in negative and questions with was and were. Example:

   a) I was angry because they were late.
   b) Was the weather good when you were on holiday?
   c) They weren’t able to come because they were so busy.

5. Regular and Irregular

*Regular*: form the past tense with adding *ed* to their simple form. Eg: I walked, we studied, she lived, etc

   a. The verb that the last letter ended by Y and before the Y is consonant, so that, the Y changes into I and then added by –ed.

   Example: To carry = carried, To dry = dried

   b. Verb ended by Y but before the Y is *Vowel*, the verb added by –ed. Example: To obey = obeyed To play = played
c. Verb one word ended by consonant, the consonant doubled in Ing form or on form II added by –ed.
   Example: To stop = stopping = stopped
          To plan = planning = planned

d. In a verb ends in –e, we add –d.
   Example: hope/hoped, smile/smiled, dance/danced.

e. If final syllable is not stressed, the final consonant isn’t doubled.
   Example: Visit/visited, develop/developed, happen/happened, remember/remembered.

f. In British English verbs ending in I have – II – before –ed whether the final syllable is stressed or not.
   Example: travel/travelled, cancel/cancelled.

g. Do not double final consonant if there are two vowels letter before it (oil – ed, etc)
   Example: boil/boiled, explain/explained, need/needed.

h. Do not double the consonant if the word ends in two consonants (-rt, -lp, -ng, etc).
   Example: start/started, help/helped.

i. Do not double Y, X or W at the end of words (at the end of word Y or W are not consonants).
   Example: stay/stayed, play/played, box/boxed.¹⁶

Irregular: like regular verbs, have the same form in all persons of the past tense. When the past simple do not end in –ed (for example “saw” the verb is irregular).

1. With some irregular verbs, all these forms (infinitive, past simple and past participle) are the same, for example “hit”.
   a) Don’t hit me. (infinitive)
   b) Somebody hit me as I came into the room. (past simple)
   c) I have never hit anybody in my life. (past participle present perfect)

2. With other irregular verbs, the past simple is the same as the past participle (but different from the infinitive), for example “tell = told”.
   a) Can you tell me what to do? (infinitive)
   b) She told me to come back the next day. (past simple)
   c) Have you told anybody about your new job? (past participle – present perfect)

Past participal is one of the principal parts of a verb. It is used in the present perfect and the past perfect tense. The past participal of regular verbs is the same as the simple past form: both end in ed.\(^\text{17}\)

The following verbs can be regular or irregular: Burn - burned or burnt, Dream – dreamed or dreamt, Learn – learned or

learnt, Smell – smelled or smelt, Spell – spelled or spelt, Listen – listened or listent etc. Time signal: Yesterday, yesterday morning, yesterday afternoon, last night, last week, last Friday, last month, last year, last century, an hour ago, all last year, in 1990, regularly, never\textsuperscript{18}.

E. Approaches to Grammar Teaching and Learning

In general, there are two basic approaches to teaching grammar; that are deductively and inductively. In deductive approach, the teacher presents the grammar rules and then gives students exercises in which they should apply the rules while in inductive approach, the teacher presents sample of language, and the students have to infer understanding from the rule.\textsuperscript{19} Actually, both two approaches are appropriate for teaching grammar. There is no better approach between them. They have their own advantages and disadvantages. As shown by Thorn burry (1999), the advantages of deductive approach are as follows:

1. It gets straight to the point and can be time-saving because many rules are more quickly explained thereby allowing more time for practice and application.

\textsuperscript{19} David Nunan,\textit{ Practical English Language Teaching: Grammar}, (Boston: McGraw Hill, 204), p. 15.
2. It confirms students’ expectations about classroom learning, particularly for those with an analytical learning style.

On the other hand, the deductive approach has also disadvantages that are as follows:

a. It may be frustrating for some students, especially younger one.

b. Grammar explanation encourages a teacher-fronted, transmission style classroom.\(^{20}\)

In other words, this approach will be beneficial for the students whose analytical ability are high and give much opportunity for students to do more practice rather than the teachers’ rules explanation. In contrary, it will be a hindrance for young learner to study grammar because they have not had the analytical ability yet.

The second approach to the grammar teaching learning, that is inductive approach, has many advantages and disadvantages as well. Here may be its advantages.

1. The rules learners discover for themselves are more likely to fit their existing mental structure than rules they have been presented and will make the rules more memorable and meaningful.

2. Students are more actively involved in leaning process, rather than being simply passive recipients.

Besides, this approach has also its advantages. Here are the following.

a. This approach frustrates students who, because of personal learning style or past learning experience, would prefer simply to be told the rule.

b. Students may hypothesize the wrong rules or their version of the rule may be either too broad or too narrow. 

It can be said that students will understand easily what the grammar point is actually taught without telling them the rule directly because they are given opportunities to think more and infer the rule from the given examples. However, not all students will enjoy when they are taught using this approach because of their different learning styles.

Regardless those two approaches, teacher actually can use either deductive or inductive approach based on the teaching learning context which may includes student learning style because there is no single approach will appropriate for all grammar items and for all learners.

F. Using Jeopardy Game to Teach Simple Past Tense

A nice way for reviewing a lesson is by playing a game in which students have fun and learn at the same time. Students love activities the consist of games. Be prepared to offer some type of reward or special privilage to the winners of the game. Have fun using

---

PowerPoint presentation software to productively review your language content in a fun and interesting way. Jeopardy is a good option for this. Implementation steps learning with Jeopardy game:

1. Teacher delivers the material to be presented.
2. Teacher develops a list of questions on the topic to measure understanding.
3. The teacher divides the class into two or four groups.
4. They are assigned to review material during the “team” phase by selecting a number from the slide. Groups must be equal in size.
5. Then each of them choose a question at a time, so they have a question to answer.
6. They have to answer the question that matches the word or sentence they selected from the slide.
7. If their answer the question was wrong, so the chance would be given to other team to answer the question in 5 second, and so on.
8. If other team gave the answer or answered the question from other team, so the score would be decreased.
9. In this case, they gotta complete the sentences putting the verbs in parenthesis in the past tense.
10. At the end of the game, the group who has more points gets a prize. It's a great activity because students decide together which

--
verb they have to say and they do it in English. It is a very nice moment for practicing the language.

11. Teacher gives a conclusion.
13. Closing.

G. **Hypothesis**

   It refers to the basis belief of researcher which enables him or her to carry out the research. It is provisional truth determined by researcher that should be tested and proved. In this research, the hypothesis can be stated as follow:

   Ha : There is a significant difference grade in simple past tense achieved by the students taught using Jeopardy Game from those taught without using Jeopardy Game.

---